Control Panel Functions

12
11

10

Parts Function
1 Left soft key Functions as shown in the bottom left of the
LCD screen.
2 Right soft key | Functions as shown in the bottom right of the
LCD screen.
3 LCD screen Displays the printer status messages, and the
panel settings.
4 © Print button | Press to start printing.
5 Cancel button | Press to cancel the printing or settings.
6 OK button Functions as shown in the LCD screen.
7 A V <> 4-way | Press to move the cursor on the LCD screen.
scroll button
8 Menu button Press to enter the Menu mode for the print
settings or maintenance options.
9 Open button Press to open the front cover.
10 | (== Display Press to change the view of the screen.
button
11 1/6 On button | Press to turn the printer on and off.
12 | Power light On when the printer is turned on and ready.
13 | Save button Shortcut button to save data to an external

device or the internal CD drive (PM 280 only).
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Printer Parts

Top cover: Holds the blank
paper straight.

Edge guides: Help load the paper
straight. Adjust the both edge guides to
fit the width of your paper.

Paper feeder: Holds your paper

and feeds it for printing. 2

S

< =

= Memory card light

Handle

Memory card slots

CD drive : Reads data from or
save data to a CD. (For
PictureMate PM 280 only)

Front cover: Receives the ejected
paper. Open the cover to insert or
eject a memory card.
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EXT. I/F (USB) port: Used to
connect the printer to the
optional Bluetooth Photo
Print Adapter and digital
cameras that have USB

DIRECT-PRINT functionality.

DC inlet

Battery cover: Remove the cover
to insert an optional battery.

Photo cartridge

Cartridge compartment cover
USB port for computer: Used
to connect the computer and
printer together using the
USB cable.
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EPSON

EXCEED YOUR VISION

Photo Printer
PictureMate..PM 240/ PM 280

No part of this publication may be reproduced, stored in a retrieval
system, or transmitted in any form or by any means, electronic,
mechanical, photocopying, recording, or otherwise, without the prior
written permission of Seiko Epson Corporation. The information
contained herein is designed only for use with this Epson printer. Epson
is not responsible for any use of this information as applied to other
printers.

Neither Seiko Epson Corporation nor its affiliates shall be liable to the
purchaser of this product or third parties for damages, losses, costs, or
expenses incurred by the purchaser or third parties as a result of
accident, misuse, or abuse of this product or unauthorized
modifications, repairs, or alterations to this product, or (excluding the
U.S.) failure to strictly comply with Seiko Epson Corporation's operating
and maintenance instructions.

Seiko Epson Corporation shall not be liable for any damages or
problems arising from the use of any options or any consumable
products other than those designated as Original Epson Products or
Epson Approved Products by Seiko Epson Corporation.

Seiko Epson Corporation shall not be held liable for any damage
resulting from electromagnetic interference that occurs from the use of
any interface cables other than those designated as Epson Approved
Products by Seiko Epson Corporation.

EPSON®is a registered trademark and PictureMate™ is a trademark
of Seiko Epson Corporation.

PRINT Image Matching™ and the PRINT Image Matching logo are
trademarks of Seiko Epson Corporation. Copyright© 2001 Seiko Epson
Corporation. All rights reserved.

USB DIRECT-PRINT™ and the USB DIRECT-PRINT logo are
trademarks of Seiko Epson Corporation. Copyright © 2002 Seiko Epson
Corporation. All rights reserved.

Microsoft® and Windows® are registered trademarks of Microsoft
Corporation.

Apple® and Macintosh® are registered trademarks of Apple Computer,
Inc.

DPOF™ is a trademark of CANON INC., Eastman Kodak Company,
Fuji Photo Film Co., Ltd. and Matsushita Electric Industrial Co., Ltd.
The BLUETOOTH™ trademarks are owned by Bluetooth SIG, Inc.,
U.S.A. and licensed to Seiko Epson Corporation.

Zip® is a registered trademark of lomega Corporation.

SDHC™ is a trademark.

Memory Stick, Memory Stick Duo, Memory Stick PRO, Memory Stick
PRO Duo, MagicGate Memory Stick, and MagicGate Memory Stick Duo
are trademarks of Sony Corporation.

xD-Picture Card™ is a trademark of Fuji Photo Film Co.,Ltd.

General Notice: Other product names used herein are for identification
purposes only and may be trademarks of their respective owners.
Epson disclaims any and all rights in those marks.

Copyright © 2006 Seiko Epson Corporation. All rights reserved.
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Safety Instructions

d Leave enough space in front of the printer for the

Important Safety Instructions paper to be fully ejected.
Read all of the instructions in this section before using O Avoid places subject to rapid changes in
your prilnter. Also, be sure to follow all warnings and temperature and humidity. Also, keep the printer
instructions marked on the printer. and the AC adapter away from direct sunlight,
strong light, water, or heat sources.
When choosing a place for the printer Do not leave the printer in a place subject to high

temperature, such as in a car. Also, keep the
printer away from direct sunlight, strong light, and
heat sources. Otherwise, the printer may be
damaged or ink may leak.

Observe the following when choosing a place for the
printer:

1 Place the printer on a flat, stable surface that
extends beyond the base of the printer in all
directions. If you place the printer by the wall,
leave more than 10 cm between the back of the
printer and the wall. The printer will not operate
properly if it is tilted at an angle.

 Avoid places subject to dust, shock, or vibration.

[ Leave enough room around the printer to allow for
sufficient ventilation.

0 Place the AC adapter near a wall outlet where the

d  When storing or transporting the printer, do not tilt plug can be easily unplugged.

it, stand it on its side, or turn it upside down.

Otherwise, ink may leak from the cartridge. O Do not place or store the printer and the AC

adapter outdoors.
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When setting up your printer

Observe the following when setting up the printer:

0

Do not block or cover the vents and openings in
the printer.

Power supply cords should be placed to avoid
abrasions, cuts, fraying, crimping, and kinking. Do
not place objects on top of power-supply cords
and do not allow the AC adapter or power-supply
cords to be stepped on or run over. Be particularly
careful to keep all power-supply cords straight at
the ends and the points where they enter and
leave the AC adapter.

Use only the power-supply cords that comes with
this product. Use of another cord may result in fire
or electrical shock, or injury.

The AC adapter model A381H is designed for use
with the printer with which it was included. Do not
attempt to use it with other electronic devices
unless specified.

Use only the type of power source indicated on
the AC adapter's label, and always supply power
directly from a standard domestic electrical outlet
with the AC power cord that meets the relevant
local safety standards.

Avoid using outlets on the same circuit as
photocopiers or air control systems that regularly
switch on and off.

Avoid using electrical outlets controlled by wall
switches or automatic timers.

Keep the entire computer system away from
potential sources of electromagnetic interference,
such as loudspeakers orthe base units of cordless
telephones.

Do not use a damaged or frayed power cord and
the AC adapter.

If you use an extension cord with the printer, make
sure that the total ampere rating of the devices
plugged into the extension cord does not exceed
the cord’s ampere rating. Also, make sure that the
total ampere rating of all devices plugged into the
wall outlet does not exceed the wall outlet’s
ampere rating.
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1 Never disassemble, modify, or attempt to repair For United Kingdom, Singapore, and Hong Kong
the AC adapter, power cord, printer, and options users
by yourself except as specifically explained in the

printer's guides [ Replace fuses only with fuses of the correct size

and rating.

[ Unplug the printer, and refer servicing to qualified

service personnel under the following conditions: Safety requirements

Mains plug:
The power cord or plug is damaged; liquid has Use a 3-pin mains plug that is registered with the
entered the printer or the AC adapter; the printer Safety Authority.
orthe AC adapter has been dropped or the casing
damaged; the printer or the AC adapter does not Flexible cord:
operate normally or exhibits a distinct change in Use a double insulated flexible cord that is certified* to
performance. (Do not adjust controls that are not the relevant IEC or BS standards.

covered by the operating instructions.)
Appliance connector:

1 Do not use with wet hands. Use an appliance connector certified* to the relevant
IEC320.
[ If you plan to use the AC adapter in Germany, the
building installation must be protected by a 10 or * certified by member of IECEE CB Scheme.
16 amp circuit breaker to provide adequate
short-circuit protection and over-current For United Kingdom users

protection for this printer. The following safety information applies to the AC

adapter.

d Warning: Refer to the rating plate for the voltage
and check that the appliance voltage corresponds
to the supply voltage.
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Important: The wires in the mains lead fitted to
this appliance are coloured in accordance with
following code: Blue - Neutral, Brown - Live

If you have to fit a plug:

 As the colours of the mains lead of the appliance

may not match the coloured markings used to
identify the terminals in a plug, please observe the
following:

The blue wire must be connected to the terminal
in the plug marked with the letter N.

The brown wire must be connected to the terminal
in the plug marked with the letter L.

If damage occurs to the plug, replace the cord set
or consult a qualified electrician.

When using the printer

Observe the following when using the printer:

0

If you use the printer in places where the use of
electronic devices is limited, such as in airplanes
or hospitals, follow all instructions in those places.

Do not insert objects through the slots in the
printer.

Take care not to spill liquid on the printer and the
AC adapter.

Do not put your hand inside the printer or touch
the photo cartridge during printing.

Do not use aerosol products that contain
flammable gases inside or around this product.
Doing so may cause fire.

Always turn the printer off using the 176 On button.
Do not unplug the printer or turn off the power to
the outlet until the power light goes out.

Before transporting the printer, make sure that the
photo cartridge is in place.

Leave the photo cartridge installed. Removing the
cartridge can dehydrate the print head and may
prevent the printer from printing.

When using a memory card

1 Use only memory cards compatible with the

printer. See “Inserting a Memory Card” on page 23

10
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When using LCD screen

[ The LCD screen contains a few small bright or
dark spots. These are normal and do not mean
that the LCD screen is damaged in any way.

d  Only use adry, soft cloth to clean the LCD screen.
Do not use liquid or chemical cleansers.

[ If the LCD screen on your printer's control panel
is damaged, contact your dealer. If the liquid
crystal solution gets on your skin, wash them
thoroughly with soap and water. If the liquid crystal
solution gets into your eyes, flush them
immediately with water. If discomfort or vision
problems remain after a thorough flushing, see a
doctor immediately.

When using the optional Bluetooth Photo
Print Adapter

Refer to the Bluetooth Photo Print Adapter's
documentation for the safety instructions.

When using the optional battery

0

If battery acid gets into your eyes or on your skin,
immediately rinse the affected area thoroughly
with water and seek medical treatment. If a battery
is swallowed, seek medical treatment
immediately.

Use only an Epson Li-ion battery model D121A for
this printer according to the directions in the user
documentation. Replacing the battery with an
incorrect model may cause an explosion.

Use only AC adapter model A381H to charge the
battery and operate the printer.

Do not charge or use the battery with devices
other than the specified product. Using the battery
with other devices may damage the battery or
other devices, or may cause an explosion.

To protect against short circuits, do not remove
the outside case of the battery.

Do not handle the battery with wet hands or use
them near water.

Do not expose the battery to water or high
humidity.
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Do not drop, puncture, disassemble, mutilate, or
short-circuit the battery.

Do not place the battery near or into fire or water.

Do not use the battery that is leaking or damaged
in any way.

Do not charge the battery on devices except this
printer.

Do not charge the battery near open flame or in
very hot locations.

Keep the battery away from heat sources.

Do not leave the battery in a vehicle to prevent the
battery from overheating.

Do not insert objects into any openings as they
may touch dangerous voltage points or
short-circuit components.

Prevent the battery from coming into contact with
metal objects that could short-circuit it, such as
coins or keys.

Do not solder wires or terminals directly to the
battery.

Do not touch battery terminals.

Keep the battery away from open flame if they leak
or smell strange.

If overheating, discoloration, or deformation
occur, remove the battery from the printer and do
not use it.

Charge the battery before usingiitif it has not been
used for a long period.

When storing the optional battery

a

When not using the printer for a long period of
time, remove the battery from the printer and store
them separately to avoid over-discharging the
battery.

Do not store the battery where the temperature or
humidity is very high.

Store the battery out of children’s reach.

12
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When disposing of the optional battery For users in the United States and Canada:

Before disposing of the battery, make sure you
discharge them completely.

This mark indicates that the battery
will be recycled by RBRC. When
you dispose of the battery, contact
RBRC.

\ Warning: . 822 .
Do not dispose of batteries as ordinary
refuse. Instead, dispose of them in a When handling photo cartridges
collection or recycle box in accordance with
local laws. Observe the following when handling photo cartridges:
Do not incinerate or dispose of the battery O Do not shake photo cartridge after removing it
in fire. from the bag; this can cause leakage.
For European users: O Do not remove or tear the label on the cartridge;
Do notdispose of batteries as ordinary refuse. Instead, this can cause leakage.

dispose of them in a recycle box in accordance with

local laws.

1 Do not use a photo cartridge beyond the date
printed on the cartridge carton: otherwise, it may
resultin reduced print quality. For best results, use
up the photo cartridge within six months of
installing it.

Do not dismantle photo cartridges or try to refill
them. This could damage the print head.
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After bringing a photo cartridge inside from a cold
storage site, allow it to warm up at room
temperature for at least three hours before using
it.

Store photo cartridges in a cool, dark place.

The IC chip on the photo cartridge retains a variety
of cartridge-related information, such as the photo
cartridge status so that the cartridge may be
removed and reinstalled freely. However, each
time the cartridge is inserted, some ink is
consumed because the printer automatically
performs a reliability check.

Store each photo cartridge so that the bottom of
its packaging faces down.

Energy Star® Compliance

ENERGY STAR

Warnings, Cautions, and Notes

\\ Warnings
must be followed carefully to avoid bodlily injury.

Cautions
must be observed to avoid damage to your
equipment.

Notes
contain important information and useful tips on the
operation of your printer.

14
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Welcome!

PictureMate™ is your easy-to-use, personal photo lab.

Just insert a digital camera memory card and you are
ready to print brilliant photos. If you are using
PictureMate PM 280, you can also print from the CD
in the internal CD drive. Because PictureMate is light
and portable, you can print whenever and wherever
you take photos.

Some functions are for PictureMate PM 280 only. So
be sure to check which printer model you are using
(PM 240 or PM 280).

A Quick Introduction to the Digital
Photography Process

1. Take Photos
Take photos with your digital
camera.

2. Print

Insert your camera’s memory
card in PictureMate or connect
via PictBridge, choose your
photos, and print.

3. Save

To preserve your digital photo
files, save them to a CD, flash
drive, or to your computer. Then
you can reprint them any time.
If you are using PictureMate PM
280, you can also save data on
a memory card to the CD in
PictureMate's CD drive.

4. Clear the Memory Card
After you save your photo files, delete them from your
memory card so you have room for more photos.
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Special features

Printing with your PictureMate becomes even easier
with these special features:

B@Botal 0 1/27
d v

@I Select Photo  GED Find

g e in B

LCD screen

/4 PictBridge

From the PictureMate LCD screen,
you can print all your photos or you
can select just the ones you want.
See “Basic Photo Printing” on page
27.

If your camera supports DPOF
(Digital Print Order Format), you
can preselect which photos to print
while the memory card is stillin your
camera. Then, when you insert the
card into PictureMate, it knows
which photos you chose. See
“Printing Camera-Selected DPOF
Photos” on page 31.

If you have a PictBridge®- or USB
DP (USB Direct Print)-enabled
camera, you can connect the
camera to PictureMate and control
printing right from your camera.
See “Printing From a
PictBridge-Enabled Camera” on
page 43.

{ If you have a Bluetooth®-enabled

& PDA, mobile phone, or computer,
you can send photos wirelessly to
PictureMate for printing. You just
need the optional EPSON®
Bluetooth Photo Print Adapter. See
“Printing From a Bluetooth Device”
on page 45.

If you want to print in other places
without convenient electrical
outlets, you can buy the optional
PictureMate battery. See “Lithium
lon Battery” on page 77.

Note:

[  PictureMate supports P..M. (PRINT Image
Matching™) image enhancement standard that is
built into many cameras. To see if your camera is
P.I.M.-enabled, see your camera’s
documentation.

16
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Supported Photo Formats

JPEG TIFF

Make sure your photos meet these requirements for
printing with your PictureMate:

a  JPEG files or uncompressed TIFF files only

[d  Resolutions ranging from 80 x 80 to 9200 x 9200
pixels

PictureMate recognizes and prints the first 999 photos
on your memory card.

Where to Find Information

All manuals are common to the PictureMate PM 240

and PM 280.

Unpacking and setting up

See the Start Here to set up your
PictureMate and install the
software.

Using PictureMate away from home

Portable Quick Guide

When taking your PictureMate out
with you, bring along the Portable
Quick Guide for simple instructions
on printing and problem solving.

Printing and changing settings

User's Guide - for use without a
computer - (this book) explains how
to print photos directly from your
camera’s memory card. It also
covers how to print from other
devices, replace the PictureMate
PicturePack, take care of
PictureMate, and troubleshoot
problems.
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Using your PictureMate with a computer

The on-screen User's Guide on the
CD provides comprehensive
information and instructions for
using PictureMate with a computer.

Paper/Layout menu

For details, see “Making Paper and Print Layout
Settings” on page 32.

Panel Setting Menu List

Select menu

For details, see “Basic Photo Printing” on page 27.

10x15¢cm (4 x 6in)

Borderless, Border, 2 Per Print, 4 Per Print,
ID, Half Page, Index (20-up), CD Index,
Digital Size

16:9 wide size

Borderless, Border, Greeting Card

Select All

Select all of the photos on your card.

Select By Date

Select photos by the date they were taken.

Select Range

Select a sequence of photos, for example 3
through 8.

Slideshow

View all photos in sequence like a slide
show.

Edit menu
Crop Photo Crop a part of your photo. (= page 36)
Color Effect Select Black & White to print your photo in
black and white. Select Sepia to print your
photo in sepia. Select None for no effect.
Fix Photos Select Auto Correction and choose a

more detailed enhancement option, or
change the Brightness, Saturation, and
Sharpness levels manually. (% page 33)

Select Source

Select the source of the photos when two
or more sources are available.

Red-Eye Reduction

Select Onto correct red-eyes in your photo.
(= page 36)

Decorate Photo

You can add, edit, or remove decorations
such as pop-up on/from your photos .
(= page 35)

Rotate

Rotate your photos by 90 degrees.
(= page 37)

Welcome!
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Frame menu

Add or delete P.I.F. Frames to or from your photo. You can also update
the P.I.F. Frames in PictureMate's internal memory (= page 37)

Save Photo(s) menu

Save all or some of the photos on a memory card to an external device
or to the CD in the CD drive (PictureMate PM 280 only).

Maintenance menu

Nozzle Check

Auto Cleaning

Head Alignment

Check PicturePack Status

Cleaning Sheet

Borderless Adjust the margins that are trimmed when you
Expansion select Borderless.
MAX: No margins are printed.
MID: The expansion rate is low. (The margins
might be printed.)
MIN: The expansion rate is lower than MID. (The
margins might be printed.)
Bluetooth Make the Bluetooth settings. (# page 47)
Direct Print If you print from a PictBridge- or USB DP-enabled
Settings digital camera, make the basic settings with this
function before printing. (% page 43)
After Printing Decide whether to keep the print settings you
selected or return the settings to the default you
selected. (% page 50)
Language Select the language to display.
Personal Change PictureMate’s default settings to your own
Settings personal preferences. (# page 51)
Photo View Select the default number to display from: 15
Mode photos, 6 photos, 1 photo (with guide), 1 photo (no

guide). (% page 27)

Setup menu

Restore default

Reset to the default settings. (# page 52)

‘ Date stamp Print the date your photo was taken.

settings?

Operation Set PictureMate to sound a tone. (% page 50)

Sound

CD Backup Selectthe speed to use when saving to the internal

Speed CD drive. You can select from High Speed or
Normal. When High Speed is selected, the
printer does not perform a verification check.

Help Display guidance for each setting.
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Preparing to Print

Before you can print, you need to load paper and insert
your memory card in PictureMate.

Note:
The illustrations in this section show the PictureMate
PM 240. The instructions for the PM 280 are the same.

Loading Paper

When loading special paper distributed by Epson, read
the instruction sheets packed with the paper first.

Follow these steps to load PictureMate Photo Paper:
Caution:

Do not load plain paper; this may damage
PictureMate.

1.

Move the handle to the back. Then open the top
cover.

Handle
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2. Raise and adjust the LCD screen so that you can 4. Slide the edge guides to the sides.
see it well.

Edge guides

5. Placeyourpaperinthe center, with the glossy side
up.

Note:
Make sure paper is glossy side up to prevent
smeatring.

6. Slide the edge guides against the paper. Make

sure they are snug, but not so tight that paper
cannot move.

Glossy side
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Note:

0

0

You can load paper up to 20 sheets.

When you need more paper, order a PictureMate
PicturePack. See “Ink, Paper, and Options” on
page 76 for more information.

Paper Handling Instructions

When storing printouts

0

Do not touch the printed side or stack your
printouts until the ink is dry.

To avoid scratching the image, be sure not to rub
the printed side of the paper. If the printed side is
rubbed too strongly, ink may come off the paper.

Do not stack printouts with the image sides
touching.

Do not stack printouts and conventional film
photographs with the image sides touching.

If you stack printouts, place a sheet of plain paper
or other absorbent paper between the individual
prints.

When storing unused paper

Return any unused paper to the original package, and
store it away from extreme temperatures, high
humidity, and bright lights.

When displaying printouts

4 When displaying your printouts indoors, Epson
recommends placing your printouts in glass
frames to preserve the colors in your image.

[ Avoid displaying your printouts outdoors or in a
place exposed to direct sunlight to prevent fading.

Note:
For best results, allow your prints to dry thoroughly for
24 hours before framing.

22
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Choosing a Photo Source Inserting a Memory Card

If two or more sources such as a memory card and 1. Press the 1/6 On button to turn on PictureMate.
external device are available, you need to set the
source of the photos by following this procedure before 2. Make sure the memory card light is off and no

you start printing photos. cards are in both slots. Then insert a memory card

into the correct slot, as shown in the illustration.

Caution:

[ Insert just one card at a time.
1. Press the Menu button.

1 Loadyourmemory card only as shown

2. Press the ¥ button to highlight the Select menu,

then press the right soft key.

Press the ¥ button to highlight Select Source
then press the right soft key.

Press the ¥ button to choose from Memory
Card, External Device, or CD (PictureMate PM
280 only), then press the right soft key.

in the following table or you may
damage your printer, memory card, or
both. If you insert a card incorrectly,
you see an error message on the LCD
screen. Remove the memory card and
insert it correctly.

1 Do not press the button on the right
side of the lower card slot when you
insert a CompactFlash card or you
cannot remove the card.

a  If the CompactFlash card is not
recognized, remove the card and
insert it again.
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Upper slot

s
==
p - Memory
% card light
turns on
A

n
<D
128MB I

1t SDHC Memory Card xD-Picture Card
SD Memory Card xD-Picture Card Type M
@ MultiMediaCard xD-Picture Card Type H

miniSDHC card *
miniSD card *

"gzly

smdepy ong ns Kows

N

Adapter

L Memory Stick
MagicGate Memory Stick
Memory Stick PRO
microSDHC card * Memory Stick Duo *
microSD card * Memory Stick PRO Duo *

MagicGate Memory Stick Duo *
* Adapter required

Lower slot

— Memory
card light
turns on

128.

CompactFlash

Microdrive

24
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3. The memory card light flashes and then stays on. Upper slot

It takes a few seconds to recognize the memory .
Push in the memory card. Pull the memory card out.

card. Now you can choose photos and layouts for

printing from the LCD screen. See “Basic Photo

Printing” on page 27.

For the latest information on memory cards available
for your printer, contact your dealer or regional Epson

sales office.
Lower slot
RemOVing the memory card Press the button on the Pull the memory card out.
right twice.

When you are ready to remove a memory card, make \ S—
sure the memory card light is not flashing, then remove S QJ

()
the memory card from the slot.

Caution: %f

Do not remove a card while the memory card

light is flashing; you may lose photos on your
card.
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Inserting a CD into the CD Drive Ejecting the CD

. . 1. Press the a gject button near the slot. The CD
You can view and print photos from a CD or save comes halfway out.

photos to the CD in the PictureMate's CD drive.
1. Make sure PictureMate is on.
2. Gently push a CD into the slot until it goes

completely into the printer. A light to the left of the
slot flashes to indicate that the CD is being read.

eject button

2. Remove the CD from the slot.

For how to save photos to the CD, see “Saving Photos
to the CD (PictureMate PM 280 Only)” on page 55
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Basic Photo Printing

Changing the View of Photos onthe LCD  Printing All Photos

Screen 1. Press the Menu button.
You can change the view of photos displayed by
pressing the (== Display button, and you can also set
the default display by using the Setup menu - Photo
View Mode setting.

2. Press the ¥ button to highlight the Select menu,
then press the right soft key.

3. Press the ¥ button to highlight Select All, then
press right soft key.

View 15 photos.

4. Press the OK button to increase the number of
D Cotares copies for all photos, then press the right soft key
to set the copies.

View 6 photos.

B @@otal 38 /19

View 1 photo with operation guides for the | U .‘E“’é ESZ
\ 0] photo. The print settings set for the photo are
© ™ shown as icons on the right side.
i} Copy - Proceed

@B Select PhotoCEDFind
Select Al Quick Tips

View 1 photo at maximum size. The print
settings set for the photo are shown as icons
on the right side.

Select All Quick Tips.

PictureMate PM 240 / PM 280 Basic Photo Printing 27



10.

Note:

If you want to set the number of copies for
specified photos only, set the copies for all first,
then select the photo you want to increase and
press the OK button until you see the desired
number of copies. To decrease the number of
copies, press the left soft key.

To make optional settings, see “Printing Options”
on page 32.

Press the right soft key to preview the print
settings.

Press the right soft key to open the Paper/Layout
menu.

Press the ¥ button to highlight the desired paper
size, then press the right soft key.

Press the ¥ button to highlight the desired layout,
then press the right soft key.

Press the & Print button to start printing.

Note:

If there is DPOF information on the memory card,
PictureMate goes to DPOF print mode. See “Printing
Camera-Selected DPOF Photos” on page 31 for
details. To print all of the photos on the memory card,
press the Cancel button and follow the steps above.

Printing Selected Photos

1.

Press the A, ¥, 4, or » button to highlight the
photo you want to print, then press the OK button.
The copy number for that photo is set to 1.

If you want to increase the number of copies,
press the OK button until you see the desired
number. To decrease the number of copies, press
the left soft key.

Repeat the steps 1 and 2 for additional photos.

To make optional settings, see “Printing Options”
on page 32.

Press the right soft key to preview the print
settings.

28
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Press the right soft key to open the Paper/Layout
menu.

Press the ¥ button to highlight the desired paper
size, then press the right soft key.

Press the ¥ button to highlight the desired layout,
then press the right soft key.

Press the @ Print button to start printing.

Printing a Range of Photos

Follow the steps below to print a range or sequence of
photos.

1.

2.

Press the Menu button.

Press the ¥ button to highlight the Select menu,
then press the right soft key.

Press the ¥ button to highlight Select Range,
then press right soft key.

Press the A, ¥, 4, or» button to highlight the first
photo, then press the right soft key.

Press the A, ¥, 4, or» button to highlight the last
photo, then press the right soft key.

B @3Selectd 9/19

Press the OK button to increase the number of
copies for all photos, then press the right soft key
to set the copies.

Note:

If you want to set the number of copies for
specified photos only, select the photo you want
to increase and press the OK button until you see
the desired number of copies. To decrease the
number of copies, press the left soft key.

To make the optional settings, see “Printing
Options” on page 32.

Press the right soft key to preview the print
settings.

Press the right soft key to open the Paper/Layout
menu.
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10.

11.

12.

Press the ¥ button to highlight the desired paper
size, then press the right soft key.

Press the ¥ button to highlight the desired layout,
then press the right soft key.

Press the @ Print button to start printing.

Printing Photos Searching By Date

If you know the date the photos were taken, you can
find and print them easily using this menu.

1.

2.

Press the Menu button.

Press the ¥ button to highlight the Select menu,
then press the right soft key.

Press the ¥ button to highlight Select By Date,
then press right soft key.

Highlight the date you want, then press the OK
button to check the date.

Press the right soft key. Photos taken on the
specified date are displayed.

10.

You can change the way the date is displayed by
pressing the (== Display button.

w s [1/07/2006 3Photas | |

154 06/07/2006
I 16/07/2008

4Photos
4Phatos

GI3 Select I Calendar

@I0 Select
Back Proceed Back Proceed

= Date

Date view Calendar view

Press the A, ¥, 4, or » button to highlight the
photo you want to print, then press the OK button.

If you want to increase the number of copies,
press the OK button until you see the desired
number. To decrease the number of copies, press
the left soft key.

To make optional settings, see “Printing Options”
on page 32.

Press the right soft key to preview the print
settings.

Press the right soft key to open the Paper/Layout
menu.
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11. Press the ¥ button to highlight the desired paper
size, then press the right soft key.

12. Press the ¥ button to highlight the desired layout,
then press the right soft key.

13. Press the ® Print button to start printing.

6. Press the ® Print button to start printing.

Printing an Index

Prints all of the photos on your memory card or from
the specified external device. The photo number is
printed at the lower left and the date or file name is
printed at the lower right of each photo.

1. Select the photos to print.
2. Press the Menu button.

3. Pressthe ¥ button to highlight the Paper/Layout
menu, then press the right soft key.

4. Press the ¥ button to highlight the 10 x 15 cm
(4 x 6 in), then press the right soft key.

5. Press the ¥ button to highlight Index (20-up),
then press the right soft key.

Printing Camera-Selected DPOF Photos

If your camera supports DPOF (Digital Print Order
Format), you can use it to preselect which photos and
how many copies you want to print. See your camera’s
manual to choose photos for printing with DPOF, then
insert your memory card in PictureMate. PictureMate
automatically reads your preselected photos.

1. Load paper and a memory card that contains
DPOF data. The screen below appears on the
LCD screen.

(5]

DPOF data was found,
Use the DPOF data?

>

No Yes

2. Press the right soft key to start printing.

Note:

If you want to print all of the photos on the memory
card, press the Cancel button. See “Printing All
Photos” on page 27.
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Printing Options

Making Paper and Print Layout Settings

You can select the print layout from the following

options.
10 x 15 cm (4 x 6 in) size 16:9 wide size
E Borderless B Borderless
IE' Border Border
|E| 2 Per Print E Greeting Card
IE' 4 Per Print
ID
@ Prints two
50.8 x 50.8 mm

size photos and
two 35 x 45 mm
size photos

Half Page

Index (20-up)

10 x 15 cm (4 x 6 in) size

CD Index
Prints 56 photos

as thumbnails

EE Digital Size

Set the number of copies for the selected photos,
then press the Menu button.

Press the ¥ button to highlight the Paper/Layout
menu, then press the right soft key.

(= Paper/Layout 1/2

Paper  |0x13cn {4xBin)
CI16:9 wide size

Choose a paper type.

Back Proceed

Press the ¥ button to highlight the desired size,
then press the right soft key. The layout menu is
displayed.
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4. Press the ¥ button to highlight the desired print Note:
layout, then press the right soft key. The selected These settings affect only your printed photos. They
paper size and layout are displayed in the upper do not change your original image files.
left corner of the LCD screen.
These settings are saved when you turn off the printer
or choose a different set of photos, so remember to

Touching Up Your Photos (ManuaI/Auto) turn off the settings when you are done.

PictureMate lets you correct the color and improve the
image quality of your photos without using a computer.
Two basic types of adjustments are available:

Automatically adjusting your photos

When you use the printer’s automatic image
adjustments, the adjustments are applied to all your

1 Automatic adjustments
photos.

If your camera supports PRINT Image Matching
or Exif Print, you can use the printer's P.I.M. or
Exif Print setting to automatically adjust your
photos for the best results.

1. Press the Menu button.

2. Pressthe ¥ button to highlight the Edit menu, then
press the right soft key.

If your camera does not support them, you can
use PhotoEnhance to make adjustments for the
type of environment in which your photos were
taken.

3. Press the ¥ button to highlight Fix Photos, then
press the right soft key.

4. Pressthe ¥ button to highlight Auto Correction,
O Manual adjustments then press the right soft key.

5. Press the ¥ button to select one of the following

If your photos are too light or too dark, you can " X
options, then press the right soft key.

adjust their brightness or control the saturation
and sharpness.
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 PhotoEnhance - Use this if a print does not
look good; for example, this may correct

images that are too dark, too bright, or backlit.

a  P..M. - Process images according to the
PRINT Image Matching information in your
digital files. This information helps to ensure
an accurate image reproduction.

@ Off - Prints photos as is or bypasses P.I.M. or
Exif Print data (default setting for files with no
P.I.M or Exif Print data).

To make manual adjustments in addition to the
automatic ones, follow the steps in the next section.

Manually adjusting your photos

1.

2.

Press the Menu button.

Press the ¥ button to highlight the Edit menu, then
press the right soft key.

Press the ¥ button to highlight Fix Photos, then
press the right soft key.

Press the ¥ button to highlight Brightness,
Saturation, or Sharpness then press the right soft
key.

5. Adjust other settings as necessary, then press the
right soft key.
6. Choose the photo you want to apply this setting
to, then press the right soft key.
Adding the Date

You can add the date your photo was originally taken
to the bottom right corner of your print.

This function is not available for some print layouts.

1.

2.

Press the Menu button.

Press the ¥ button to highlight the Setup menu,
then press the right soft key.

Make sure Date Stamp is highlighted, then press
the right soft key.

Press the ¥ button to highlight On, then press the
right soft key.

a  Off (default, turns off the date stamp)

d  On (date, month, year: 26.Aug.2006)
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Decorating Your Photo
You can decorate your photos by adding clip art from

PictureMate's memory. You can add up to four pieces
of clip art to a photo.

‘ - =;I ‘ - ;i
i N » SN
4 T

1. Highlight the photo you want to decorate.
2. Press the Menu button.

3. Pressthe ¥ button to highlight the Edit menu, then
press the right soft key.

4. Press the ¥ button to highlight Decorate Photo,
then press the right soft key.

5. Highlight Add Decoration, then press the right
soft key.

6. Highlight the clip art you want to add, then press
the OK button.

7. Tomove the clip art, use the 4-way scroll buttons.
To resize the clip ar, first press the right soft key
and then use both of the soft keys.

8. Pressthe OK button to set the position. If you add
more clip art, press the right soft key and repeat
the steps 6 to 8.

9. Press the OK button to complete adding clip art.
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Cropping and Sizing Your Photos

You can printjust part of a photo, cropping out the area
that you do not want. You can choose only one photo
to crop at a time.

1.

2.

Highlight the photo you want to crop.
Press the Menu button.

Press the ¥ button to highlight the Edit menu, then
press the right soft key.

Make sure Crop Photo is highlighted, then press
the right soft key.

Use the right soft key to crop a photo. You see a
blue frame around the cropped area.

Zoon Out Zoom In

Use the following buttons to set the area you want
to crop.

[ Press the right or left soft key to change the
frame size.

1 Press the A, ¥, «, or » button to move the
frame.

O Press the (== Display button to rotate the
frame.

7. Press the OK button to confirm the cropped
image.

Removing Red-eye
When you take photos of people, they sometimes
appear to have red-eyes in the photo. You can apply
Red-Eye Reduction to help eliminate this problem.

1. Highlightthe photo from which you wantto remove
red-eye.

2. Press the Menu button.

3. Pressthe ¥ button to highlight the Edit menu, then
press the right soft key.

4. Press the ¥ button to highlight Red-Eye
Reduction, then press the right soft key.
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5. Pressthe ¥ button to highlight On, then press the
right soft key.

6. Choose the photo you want to apply this setting
to, then press the right soft key.

Note:
Depending on the type of photo, parts of the image
other than the eyes may be corrected.

5. Press the ¥ button to highlight 90 degrees, 180
degrees, 270 degrees, or Do Not Rotate then
press the right soft key.

Rotating a Photo on the LCD Screen

You can rotate photos in the photo frame by 90
degrees.

Note:

This function rotates the photo image displayed on the
LCD screen. It does not affect the printed photos.

1. Highlight the photo you want to rotate.

2. Press the Menu button.

3. Pressthe ¥ button to highlight the Edit menu, then
press the right soft key.

4. Pressthe ¥ button to highlight Rotate, then press
the right soft key.

Printing with P.L.F. Frame

You can decorate your photo by printing it with a P.1.F.
Frame! With this option, the photo is printed
borderless. PictureMate stores P.I.F. Frames in its
internal memory. This section explains how to choose
P.I.LF. Frames in the printer or from other devices and
then print them with your photos.

You can copy P.I.F. Frames from your PC to a memory
card by using EPSON PRINT Image Framer Tool
software contained in the software CD-ROM. For
details on using the software, see the on-screen User’s
Guide.
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If you want to use P.l.F. Frames other than those
in PictureMate's internal memory, prepare the
media containing digital photo data and P.I.F.
Frames and connect it.

Note:

You can combine photo and P.I.F. Frames in
the same device or within PictureMate itself.
PictureMate PM 280 users can combine
photos and P.I.F. Frames on an inserted
memory card and CD media in the internal CD
drive.

 Be sure to save the P.I.F. Frame to the
memory card using the EPSON PRINT Image
Framer Tool; otherwise the P.I.F. Frame file
name does not appear on the LCD panel.

Highlight the photo you want to print with a P.I.F.
Frame.

Press the Menu button.

Press the ¥ button to highlight the Frame menu,
then press the right soft key.

Press the ¥ button to highlight Add Frame to
Photo, then press the right soft key. P.I.F. Frames
that are available in PictureMate and in the device
where the photo data is stored are displayed.

Pressthe A, ¥, < or» button to highlight the P.I.F.
Frame you want to use, then press the OK button.

Note:

The paper sizes you can use to print with the
selected P.I.F. Frame appear in the upper left of
the screen.

D FindFrane
Back Proceed

Choose the photo you want to apply this setting
to, then press the right soft key.

(5]

Select photo(s) to
which to add frane.

Back 0K

Press the OK button to increase the number of
copies. To decrease the number of copies, press
the left soft key.

Repeat the steps from 2 to 8 for additional photos.
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10.

11.

12.

13.

14.

Press the right soft key to preview the print
settings.

Press the right soft key to open the Paper/Layout
menu.

Press the ¥ button to highlight the desired paper
size, then press the right soft key.

Press the ¥ button to highlight the desired layout,
then press the right soft key.

Press the ® Print button to start printing.

Updating P.1.F. Frames in PictureMate

PictureMate stores P.I.F. Frame data within itself. You
can copy the P.I.F. Frames in the following devices
and update the P.I.F. Frames in PictureMate’s internal

memory.
4  Memory card

1 External device

[ CD media in the internal CD drive (PictureMate

PM 280 only)

Follow the steps below to update the P.I.F. Frames in
PictureMate.

1.

Connect or insert the device that contains P.I.F.
Frames for updating.

Press the Menu button.

Press the ¥ button to highlight the Frame menu,
then press the right soft key.

Press the ¥ button to highlight Update Frames,
then press the right soft key.

If a confirmation message is displayed telling you
that PictureMate will clear the print settings, press
the right soft key to select Yes.

Press the ¥ button to select the source to update
the P.I.F. Frame, then press the right soft key.

[i]

Select frame source

xternal Device B

Internal Memory

Proceed
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Caution:

Do not connect or remove a memory card,
an external device, or a CD, and do not
move PictureMate while updating P.I.F.
Frames.

The P.1.F. Frame listis displayed. Select the P.I.F.
Frame to update. The current data volume for the
allocated space for P.l.F. Frame is shown on the
right. P.I.F. Frame data that exceeds 100% is not
updated.

Note:

Frames stored in PictureMate's internal memory
are checked. Frames read from the connected
device are not checked.

You can select or deselect the Frames to store in
the internal memory by using the OK button.

Press the right soft key to update.
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Printing From an External Device

PictureMate can print stored photos on a computer or 2. Make sure there are no memory cards in

on another device such as an external hard drive, a PictureMate’s memory card slots. The card light
Bluetooth-enabled device, or a digital camera. should be off.

Note: Note:

lllustrations in this section show the PictureMate PM If a memory card is inserted, the printer will read
240. The instructions for the PM 280 are the same. photos from the card, not from an external drive.

3. If PictureMate is connected to a computer,
Printing From an External Drive disconnect it or turn off the computer.

If you saved your photos to a CD, Zip disk, or flash
memory (thumb) drive, you can connect to the drive to
the back of PictureMate and print just like you do when
you insert a memory card.

You can also print photos from a CD that you get from
a photo processing lab. (Images should be in JPEG
file format. Some CDs may not work.)

1. Make sure PictureMate is on.
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Connect your CD or Zip drive’s USB cable, or plug
your flash memory drive into the EXT. I/F port on
the back of PictureMate.

For a CD or Zip drive, insert a CD or Zip disk with
photos into the drive.

If you used PictureMate to save photos on the
same CD-R, Zip disk, or flash memory drive more
than once, it will have multiple folder. You see this
message:

Select Folder

ﬂi Photos found,

(113 Select a folder,
(X0 then press [OK].

1

0K

Press V¥ to highlight the folder where your photos
are stored, then press the right soft key. The most
recently saved folder has the largest number.

PictureMate counts the photo on your drive, then
shows the following screen:

If you see this screen, you are ready to choose
and print photos. See “Basic Photo Printing” on
page 27 and print your photos.

B @Bletal 0 22/22

@T3 Select Photo  &ED Find
Select All Quick Tins
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Printing From a PictBridge-Enabled
Camera

You can connect your PictBridge- or USB DP-enabled
digital camera to the back of PictureMate and use the
camera to control printing. (See your digital camera's
documentation to see if it supports the PictBridge
standard or USB DP.)

1.

2.

Make sure PictureMate is on.

Make sure there are no memory cards in
PictureMate’s slots. The memory card light should
be off.

Note:
If a memory card is inserted, the printer will read
photos from the card, not from a camera.

Press the Menu button.

Press the ¥ button to highlight the Setup menu,
then press the right soft key.

Press the ¥ button to highlight Direct Print
Settings, then press the right soft key.

Follow the on-screen instructions to make the
Direct Print Settings.

Direct Print Settings

Paper/Layout [2]
Color Effect None
Fix Photos

Red-Eve Reduction On
Date Stanp On

Back Proceed

Connectyour camera’s USB cable to your camera
and the EXT. I/F port on the back of PictureMate.
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8. Use the digital camera to select the photo you
want to print. Be sure to make the desired print
settings on the digital camera because the digital
camera settings generally take precedence over
the print settings of PictureMate. See your digital
camera's documentation for information on more
detailed settings.

9. Print from the digital camera.
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T e Note:
Pr ’nt’ng From a Bluetooth Device [  While this product complies with the Bluetooth

Specification, it is not guaranteed to work with all
devices enabled with Bluetooth wireless

About the Bluetooth Photo Print Adapter technology.
The optional Bluetooth Photo Print Adapter is a Q  The communication range of this product is
wireless communication module used to print from approximately 10 meters; however, this may vary
digital cameras and other devices with Bluetooth depending on conditions including obstacles
wireless technology without cables when connected to between devices; signal quality; magnetic fields;
the printer. static electricity and electromagnetic interference;

software; operating system; reception sensitivity;
and antenna performance.

Available Profile
Basic Printing Profile (BPP)
Basic Imaging Profile (BIP)
Printable file size is up to 2.5 MB. Up to 10 jobs can
be queued (Maximum 3 MB).
Hardcopy Cable Replacement Profile (HCRP)

Object Push Profile (OPP)
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Connecting and disconnecting the
Bluetooth Photo Print Adapter

Connecting

1. Insertthe Adapter connector into the EXT. I/F port
as shown below.

Caution:
Do not connect this product while the
printer is operating. Doing so may cause
the printer to malfunction.

2. The Adapter’s light comes on for one second. If
the LED does not turn on, disconnect the Adapter
from PictureMate, then reconnect it.

Disconnecting

Remove the Adapter’s connector from the EXT. I/F
port as shown below.

Caution:
Do not remove this product while
communicating with another device.

[ Do not disconnect this product while the
printer is operating. Doing so may cause
the printer to malfunction.

a Do not remove this product by pulling on its
upper section. Doing so may damage the
product.
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Bluetooth settings

Use the LCD screen on PictureMate to make settings
for Bluetooth wireless communication.
= See “Making settings” on page 48

Outline of settings

elect a nane for the

Buetooth device

Back Proceed

Bluetooth Device
Name

Setting Choices Description
printer If multiple printers
name-(number) enabled with Bluetooth
(Default = 1) are in the same

communication range,
distinguish them by
assigning each number
from 0 through 9.

To make the Device
Name setting take effect,
turn the printer off and
then back on.

Blutooth 1
BT Comn O Discoverable
e C) Not Discoverable
& Pairing

Select 2 Bluetooth
Conmunication node.

Back Proceed

Bluetooth
Communication
Mode

Discoverable

Thismode allows devices
enabled with Bluetooth to
freely discover the printer
and print.

Not Discoverable

This mode prevents
unknown devices from
discovering the printer.

To printin this mode, first
search for the printer
once in Discoverable
mode. After your device
has discovered the
printer in Discoverable
mode once, it will
subsequently be able to
communicate with and
print from it in this mode.

Pairing

This mode requires that
the four-digit Passkey be
entered into a device
before it can
communicate with and
print from the printer.

Blugtooth i
Encryption [
Ooft

Bluetooth
Encryption

On/Off
(Default = Off)

Select On to encrypt
communication.
Encryption requires that
the four-digit Passkey be
entered into a device
before it can
communicate with and
print from the printer.
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oot 11|

Passkey

"
-ll]-ﬂ [}

Bluetooth Passkey

Any four-digit
number
(Default = 0000)

The Passkey setting
allows you to set the
four-digit Passkey that
must be entered into a
device before printing if
Pairing is selected as the
BT Comm Mode or if
Encryption is On.

BT Device Address

08-03-T6-62-11-61

Back 0K

Bluetooth Device
Address

Set at the factory
(Example)
11-11-11-11-11-11

Displays the unique
Bluetooth Device
Address of the printer.

Making settings

1. Connect the Bluetooth Photo Print Adapter to

PictureMate.

=» See “Connecting and disconnecting the
Bluetooth Photo Print Adapter” on page 46

Caution:
Be sure that the printer is not operating

before connecting this product. Otherwise,

the printer may malfunction.

2. Press the Menu button.

3. Press the ¥ button to highlight the Setup menu,

then press the right soft key.

Press the ¥ button to highlight Bluetooth, then
press the right soft key.

2% Setup

Date Stamp
Borderless Expansion
Bluetoot

Direct Print Settings
After Printing
Language

Back Proceed

Make sure Bluetooth Settingsis highlighted, then
press the right soft key.

Press the right soft key to select the desired
Bluetooth option.

Change the settings of each item using the A, Vv,
<, or P button. See “Outline of settings” on page
47 for information about Bluetooth settings except
Passkey setting. See the “The Bluetooth Passkey
Setting” on page 49 to set the Passkey.
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The Bluetooth Passkey Setting

1.

Press the A or ¥ button to select a number for the
digit, then press the OK to set the number.

Bluetooth i
Passkey .
{l]bll (I}

Enter a Passkey.

Back 0K

Note:
Press the « button to return to the digit on the left.

Select numbers for the other digits in the same
manner, then press the right soft key.

At the confirmation screen, press the right soft key
to activate the Passkey.

Printing

1.

Make sure the Bluetooth Photo Print Adapter is
connected to PictureMate and Bluetooth settings
have been made. For details on connecting the
Bluetooth Photo Print Adapter, see “Connecting
and disconnecting the Bluetooth Photo Print
Adapter” on page 46. See “Bluetooth settings” on
page 47 to set the Bluetooth settings.

2. Use the PictureMate’s control panel to adjust the
print settings. (For example Paper/Layout and
Color Effect.)

3. Printthe data from your Bluetooth enabled device.

Note:

The settings available may vary among Bluetooth
wireless-capable devices. For more information, refer
to your device’s documentation.

For more information about printing from Bluetooth
wireless-capable mobile phones, digital still cameras,
digital video cameras, PDAs, mobile PCs and other
Bluetooth wireless-capable device, refer to the
documentation for both the device and the printer.
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Setting PictureMate Preferences

., d Bufton : Bleeps when an invalid button is
Set Operatlon Sound On or Off pressed or grayed-out unavailable item is

. . selected.
Set the Operation Sound setting to On to set
PictureMate to sound a tone, for example when an 5.

: Press the ¥ button to highlight On, then press the
error or warning occurs.

right soft key.

1. Press the Menu button.

2. Press the ¥ button to highlight the Setup menu, Sett'ng the After P”nt’ng Confirmation
then press the right soft key. . ) . .
This setting lets you decide whether to keep the print
settings you selected or return the settings to the
default you selected in After Printing setting. For more
information on making your own default settings, see
“Changing the Default Print Settings” on page 51.

3. Pressthe ¥ button to highlight Operation Sound,
then press the right soft key.

4. Press the ¥ button to highlight the setting you
want to change, then press the right soft key.
1. Press the Menu button.

0 Battery Status : Beeps when the battery is

low. 2. Press the ¥ button to highlight the Setup menu,

then press the right soft key.

0 Error Status : Beeps when the cartridge is

expended or the paper is out. 3. Pressthe ¥ button to highlight After Printing, then

press the right soft key.
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Press the ¥ button to highlight the desired
settings, then press the right soft key.

1 Ask Each Time : Display the confirmation
screen after printing and let you choose
whether to keep your settings or return to the
default you selected.

a  Save Settings : Keep the settings after
printing.

1 Clear Settings : Default. Return to the
personal default settings.

Note:

Even when you selectSave Settings or Ask Each
Time and choose to keep the settings, they will not
be kept in the following cases.

a  When you select another print option.

a  When the memory card is removed.

1 When PictureMate is turned off.

Setting the Language on the LCD Screen

You can change the languages that is displayed on the
LCD screen.

1.

2.

Press the Menu button.

Press the ¥ button to highlight the Setup menu,
then press the right soft key.

Press the ¥ button to highlight Language, then
press the right soft key.

Press the ¥ button to highlight your preferred
language, then press the right soft key.

Changing the Default Print Settings

You can change the PictureMate’s default settings to
your own personal preferences.

1.

2.

Press the Menu button.

Press the ¥ button to highlight the Setup menu,
then press the right soft key.
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3. Pressthe ¥ button to highlight Personal Settings, 4. Atthe confirmation screen, press the right soft key
then press the right soft key. to reset all the print settings.

4. Follow the on-screen information to change the
settings.

Resetting All Print Settings

Follow the steps below to reset the print settings you
have changed. Adjusted values for head alignment,

Bluetooth settings, and the language setting are not
reset.

1. Press the Menu button.

2. Press the ¥ button to highlight the Setup menu,
then press the right soft key.

3. Press the ¥ button to highlight Restore default
settings?, then press the right soft key.
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Saving Your Photos (Backup)

Saving Photos to the External Device

Note:
Illustrations in this section show the PictureMate PM
240. The instructions for the PM 280 are the same.

You can choose your photo files on your memory card
and save them to one of the following devices by
connecting the device directly to PictureMate. Except
for the Flash memory drive, you can save photos to
several disks when the photo data size is larger than
the disk size.

1 CD-R/RW drive (CD-R/DVD-R media only)
[ MO drive

0 lomega® Zip® disk (100, 250, or 750 MB)
[  Flash memory (thumb) drive

Note:

Epson cannot guarantee the compatibility of any
drives.

Make sure PictureMate is on.
Insert your memory card into PictureMate.

If you have inserted a CD in the internal CD drive,
remove it.

If you are using a CD-R/RW drive or Zip drive, plug
it into an electrical outlet if required.

Connect the drive to PictureMate.
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a ForaCD-R/RW, MO or Zip drive, connect its [ Fora flash memory drive, plug itinto the EXT.
USB cable to the EXT. I/F port on the back of I/F port on the back of PictureMate.
PictureMate. Theninserta CD-R/DVD-R, MO
or Zip disk in the drive.

Note:
If you want to save specified photos only, select
the photos first.

6. Press the Menu button.

7. Pressthe ¥ button to highlight the Save Photo(s)
menu, then press the right soft key.

8. Select All Photo or Selected Photos, then press
the right soft key.

9. When the confirmation message appears, press
the right soft key.
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10. If a message asking if you want to print an index
of the saved photo(s) is displayed, select Yes or
No. If you select Yes, the printer starts printing
photos to be saved in [# CD Index layout after
saving the photos to a disk. This layout prints a
maximum of 56 thumbnails. Load 4 x 6 inch photo
paper in the paper feeder.

11. Follow the instructions on the LCD screen to save
photos.

Note:
You cannot cancel saving data once it has started.

12. When saving photos has finished, press the right
soft key.

Caution
Do not remove the drive or memory card while
the photos are being saved, or you may lose
photos on your card or drive. You can save
photos multiple times to the same disk or drive
until it is full. Each time you save photos on the
same disk or drive, they are saved in a new
folder. The first folder is named 001, the second
folder is named 002, and so on. If you save on
a CD-R/DVD-R, PictureMate names the
CD-R/DVD-R Photo.

Saving Photos to the CD (PictureMate
PM 280 Only)

You can save photo data on a memory card to the CD
in PictureMate’s internal CD drive. Afterwards, you can
print the photos that you saved to a CD. If the photo

data is larger than the CD capacity, you can save the
data separately on several CDs.

Precautions

d Do not insert media or material other than 12-cm
CD, such as 8-cm CD, into the CD drive. Doing so
may cause the printer to malfunction or you may
not be able to eject.

While saving your data to a CD, be aware of the
following points to keep your photo data safe. If the
save fails, data that is being saved or saved data may
not be read. Even if you avoid the following, a writing
error may occur. Use an authentic brand and refer to
its documentation to store the CD safely.

[ Avoid turning off PictureMate. The CD itself may
be damaged and may not be reused later.
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To protect your data from vibrations, shocks, and
static electricity, do not touch PictureMate while
saving.

Do not eject the CD or operate the printer.
Before writing data to the CD using battery power,
make sure the battery is charged in advance, or
there is enough power charge.

Do not replace the battery, connect or disconnect
the AC cable, or change the power source
between AC power and battery.

Avoid replacing the photo cartridge or loading
paper.

Do not move or carry your PictureMate.

The backed up CD is ejected automatically when
the back up is finished. Leave more than 10 cm
space around the CD drive slot.

Do not vibrate or shock the printer.

Do not connect or disconnect a USB cable.

Do not open or close the top cover.

Inserting a CD in the CD drive

1.

Before you start, check that your CD meets the
following specifications. Only 12-cm CDs are
compatible with this printer.

* CD-R e CD-RW Multi

* CD-RW High * CD-RW Ultra

Supports both 650 MB (74 min.) and 700 MB (80 min.) capacities
for each of the above media.

Make sure PictureMate is on.
If you do not want to save all of the photos, select

the photos to save. If you want to save all of the
photos, proceed to the next step.
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Gently push a CD into the slot until it goes
completely into the printer. A light to the left of the
slot flashes to indicate that the CD is being read.

Saving photos to the CD

1.

2.

Insert your memory card into PictureMate.

If you do not want to save all of the photos, select
the photos to save. If you want to save all of the
photos, proceed to the next step.

Press the Save button. (Or, press the Menu
button, select Save Photo(s), then press the right
soft key.)

Select AllPhotos or Selected Photos, then press
the right soft key.

On the confirmation screen, confirm the number
of photos to save, then press the right soft key to
proceed.

If a message asking if you want to print an index
of the saved photo(s) is displayed, select Yes or
No. If you select Yes, the printer starts printing
photos to be saved in [#| CD Index layout after
saving the photos to a disk. This layout prints a
maximum of 56 thumbnails. Load 4x6 inch photo
paper in the paper feeder.

Follow the instructions on the LCD screen to save
photos.

After PictureMate has saved the photo data to a
CD, it ejects the CD. Remove it from the slot.
When you save to several CDs, insert another CD
and continue backing up.
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Replacing the PicturePack

The PicturePack contains a new photo cartridge and
photo paper.

Checking the PicturePack Status

When the PicturePack is low on ink, you see this icon
in the upper-right corner of the LCD screen.

4. Yousee ascreenshowingthe PicturePack status.
Press the right soft key to close the screen.

(5]

- 100%

Back 0K

Ink low

Bl 7/ K0

EN B BT

=[]

@IB Select Photo  GED Find
Select All QuickTips

You can check the PicturePack status at any time.

1.

2.

Press the Menu button.

Press the ¥ button to highlight the Maintenance
menu, then press the right soft key.

Press the ¥ button to highlight Check
PicturePack Status, then press the right soft key.

Replacing the PicturePack

When PicturePack needs replacement, you see a
message on the LCD screen.

Note:
Illustrations in this section show the PictureMate PM
240. The instructions for the PM 280 are the same.

PictureMate uses PicturePack equipped with an IC
chip. The IC chip monitors the PicturePack status.
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\\ Warning:
Keep photo cartridges out of the reach of
children. Do not allow children to drink from or
handle the cartridges.

Caution:
 Epson recommends the use of genuine
Epson photo cartridges. Epson warranties
do not cover damage to your printer
caused by the use of photo cartridges not
manufactured by Epson.

1 Leave the old cartridge installed in the
printer until you have obtained a
replacement; otherwise, ink remaining in
the print head nozzles may dry out.

O Do not refill photo cartridges. Other
products not manufactured by Epson may
cause damage that is not covered by
Epson’s warranties, and under certain
circumstances, may cause erratic printer
behavior.

Note:

In addition to the ink used during an image printing, ink
is consumed during the print head cleaning operation,
and during the self-cleaning cycle which is performed
when the printer is turned on.

For more information about photo cartridges.
=» See “When handling photo cartridges” on page 13

1. Make sure that PictureMate is on, but not printing.

2. Open the cartridge compartment cover on the
back of PictureMate.
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Set the cartridge lever in the Release position by
pulling it to the left. The photo cartridge will be
ejected about halfway out of the cartridge holder.

Pull the cartridge out of PictureMate and dispose
of it properly.

Note:

a

Do not take the used cartridge apart or try to
refill it. Do not shake the used photo cartridge;
otherwise, it may leak.

The photo cartridge must be replaced when
any one of the colors is depleted. The rate that
a specific color of ink is consumed depends
on the images printed.
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5. Remove the replacement photo cartridge from its

package.
Caution:
[ Do not touch the green IC chip on the

0

= > Do not touch this part.
E o S

side of the cartridge. This can damage
the photo cartridge.

If you remove the photo cartridge for
later use, be sure to protect the ink
supply ports from dirt and dust; store it
in the same environment as the
printer. Note that there is a valve in the
ink supply ports, making covers or
plugs unnecessary, but care is needed
to prevent the ink from staining items
that the cartridge touches. Do not
touch the ink supply ports or
surrounding area.

1 Be sure to always install a photo

cartridge into the printer immediately
following the removal of the current
photo cartridge. If a photo cartridge is
not installed promptly, the print head
may dry out, rendering it unable to
print.

Place the cartridge properly into the cartridge
holder, then pushitin until you feel resistance and
hear the cartridge faintly click into place.
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7. Set the lever to the Lock position by sliding it to
the right.

8. Close the cartridge compartment cover.

Note:

If you cannot close the cartridge compartment cover,
the photo cartridge is not installed correctly. Go back
to the step 4 and eject the photo cartridge. Then install
the photo cartridge again.
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Transporting Your PictureMate

PictureMate’s handle makes it easy to carry short
distances. If your PictureMate is going to travel a
longer distance, you should pack it carefully following
the steps below to protect it from getting damaged.

Caution:
Keep PictureMate out of the sun and don’tleave
it in your car or other location where it can get
foo hot.

' Ezeea
1. If PictureMate is on, turn it off.

2. Wait until the LCD screen goes blank, then unplug
the power cord from the electrical outlet.

3. Remove paper from the paper feeder and front
cover. Remove the CD if it is in the CD drive
(PictureMate PM 280 only).

4. Close the LCD screen.

5. Close the top cover and front cover.

6. Disconnect the power cord and any connected
USB cable from the back of PictureMate.

7. Pack the power cord, AC adapter, paper, spare
photo cartridge, and all manuals in the travel case.

8. Pack PictureMate and the travel case in the box
that PictureMate came in.
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Caution:
Make sure the photo cartridge is installed
before transporting. Do not place
PictureMate on its side or upside down, or
ink may leak.

Note:

If your prints do not look as good after PictureMate
has been moved, try aligning the print head. See
“Aligning the Print Head” on page 66.
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Maintaining PictureMate

Cleaning and Checking the Print Head
Nozzles

If your print quality is not as good as it used to be, if
your photos are light or faint, or you are missing colors
in your prints, your print head nozzles may be clogged.

Note:

d  Printhead cleaning consumes some ink. To avoid
wasting ink, clean the print head only if print quality
declines; forexample, ifthe printout is blurry or the
color is incorrect or missing.

1  Usethe Nozzle Check function first to confirm that
the print head needs to be cleaned. This saves ink.

[ Ifamessage on the LCD screen tells you that the
cartridge needs replacement or is low on ink, you
cannot clean the print head. You must first replace
the photo cartridge.

1. Make sure that PictureMate is turned on and no
warnings or errors are displayed on the LCD
screen.

Load a sheet of paper. See “Loading Paper” on
page 20.

Press the Menu button.

Press the ¥ button to highlight the Maintenance
menu, then press the right soft key.

Press the ¥ button to highlight Auto Cleaning,
then press the right soft key.

If a confirmation message is displayed, press the
right soft key to select OK. The cleaning starts.
The processing icon appears on the screen while
cleaning is in progress.

(]

Auta cleaning...
Please wait,

[ et |

Press the right soft key, then press the & Print
button to print the nozzle check pattern.
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8.

Examine the nozzle check pattern you printed.

Below are sample printouts.

Okay

Needs Cleaning

I
il

i

W [
Qi [
PRbi) Y

The above sample may be shown in black and white, but the actual
test prints in color (Black, Cyan, Magenta and Yellow).

If the nozzle check page does not print satisfactorily
(for example, if any segment of the printed lines is
missing), your print head nozzles may be clogged.

9.

If the nozzle check pattern is satisfactory, press
the right soft key. If the nozzle check pattern is not
satisfactory, press the left soft key and clean the
print head again. If you do not see any
improvement after cleaning about two times,
check the solutions beginning on page 72. You
can also turn the printer off and wait for at least 6
hours - this allows any dried ink to soften-and then
try cleaning the print head again.

Aligning the Print Head

If you have moved PictureMate and the print quality is
not as good as it was before—for example, you see
misaligned vertical lines or light or dark horizontal
banding—you may need to align the print head.

1.

Make sure that PictureMate is turned on and no
warnings or errors are displayed on the LCD
screen.

3

Load a sheet of photo paper. See “Loading Paper
on page 20.

Press the Menu button.

Press the ¥ button to display the Maintenance
menu, then press the right soft key.

Press the ¥ button to highlight Head Alignment
then press the right soft key.

%, Haintenance
Nozzle Check
Auto Cleaning

Head Alignnent
Check PicturePack Status
Cleaning Sheet

Back Proceed
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6. Press the right soft key to proceed.

7. Press the @ Print button to print the Head
Alignment Pattern.

8. The following Head Alignment Pattern is printed.

#1

#2 .

9. Look at the alignment pattern in each set and find
the patch which is most evenly printed, with no
noticeable streaks or lines.

10. Press the A or ¥ button to highlight the number
for the best pattern (1 to 9) for set #1, then press
the right soft key.

Head Alignment

1/2

Select the number of
the pattern in set #1
with the smallest
visible bands, then
press the Next button.

Cancel

Next

11. Select the number for set #2, then press the right

soft key.
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Cleaning PictureMate

Cleaning the roller inside

When you use Epson Ultra Glossy Photo Paper, use
this function to clean the roller inside PictureMate.

1.

2.

Load several sheets of paper.
Press the Menu button.

Press the ¥ button to highlight the Maintenance
menu, then press the right soft key.

Press the ¥ button to highlight Cleaning Sheet,
then press the right soft key, then follow the
instructions on the LCD screen.

Repeat Steps 2 to 4 if needed, and press the left
soft key to exit.

Cleaning the outer case

To keep PictureMate operating at its best, clean it
thoroughly several times a year as follows.

Turn off PictureMate and unplug the power cord.
Remove any paper from the paper feeder.

Use a soft brush to carefully clean away all dust
and dirt from the paper feeder.

If the outer case or the inside of the paper feeder
is dirty, wipe it with a soft, clean cloth dampened
with mild detergent. Keep the front cover closed
to prevent water from getting inside.

Caution:
[ Never use alcohol or thinner to clean the
printer, as these chemicals can damage
the components as well as the case.

 Be careful not to get water on the printer
mechanism or electronic components.

[ Do not use a hard or abrasive brush.

Do not spray the inside of the printer with
lubricants. Unsuitable oils can damage the
mechanism. Contact your dealer or a
qualified service person if lubrication is
needed.
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Troubleshooting

The solutions herein are for problems when printing
without using a computer.

Error Messages

Solution

Error/Warning Messages

You can diagnose and solve most problems by
checking the error messages on the LCD screen. If
you cannot solve the problems, by checking the
messages, use the following table and try the
recommended solution.

PictureMate beeps or bleeps when an error occurs.
For details on the error sounds, see page 50.

PicturePack low. Replace
PicturePack soon.

Press the right soft key to clear the error.
Prepare the new PicturePack.

If you tried to clean the print head,
replace the PicturePack first.

= See “Replacing the PicturePack” on
page 58

Replace the PicturePack.

Replace the PicturePack with the new
one.

= See “Replacing the PicturePack” on
page 58

Error Messages

Solution

Service required. Parts
inside your printerare near
the end of their service life.
See your printer
documentation.

A printer error has
occurred. See your printer
documentation.

Turn PictureMate off and then back on.

If the error message still appears,
contact your dealer.

= See “Contacting Customer Support
on page 75

Service required. Parts in
your printer are at the end
of their service life. See
your printer
documentation.

Contact Epson for assistance.

= See “Contacting Customer Support”
on page 75

Bluetooth adapter error.
Re-insert adapter.

Disconnect the Adapter, then reconnect
to the printer.

= See “Printing From a Bluetooth
Device” on page 45
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Error Messages

Solution

Error in data. Printouts
may be affected.

The print results may not be perfect.
Check the data.

The image is too large.
See your printer
documentation.

The image is too complex.
See your printer
documentation.

Press the OK button to clear the error.
Check the data.

Cannot recognize the
external device. See your
printer documentation.

Disconnect the device and check that it
meets the PictureMate specifications.

Cannot recognize the
memory card. See your
printer documentation.

Make sure the memory card has been
inserted correctly. If so, check to see if
there is a problem with the card and try
again.

The battery is empty.

Connect the AC adapter.

Battery overheating.

Turn the PictureMate off, and wait until
the battery temperature decreases.

The battery voltage is
abnormal.

Turn the PictureMate off. Replace the
battery with a new one.

Cannot recognize CD
contents. See your printer
documentation.

Remove the CD from the CD drive and
check your CD is compatible with this
printer.

Printer Power Problems
LCD screen is off

1 Press the 170 On button to make sure that
PictureMate is on.

[  Turn off PictureMate and make sure that the
power cord is securely plugged in.

[ Make sure that your outlet works and is not
controlled by a wall switch or timer.

LCD screen came on and then went out

The PictureMate’s voltage may not match the outlet
rating. Turn off PictureMate and unplug itimmediately.
Then, check the printer labels.

Caution:
If the voltage does not match, DO NOT PLUG
YOUR PRINTER BACK IN. Contact your
dealer.
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Print and Noise Problems

PictureMate makes an unexpected noise after you
install a photo cartridge.

The first time you install the photo cartridge,
PictureMate will charge its print head for about three
and a half minutes. Wait until charging finishes before
you turn it off, or it may charge improperly and use
more ink the next time you turn it on.

PictureMate makes an unexpected noise whenyou
turn it on or after it has been sitting for awhile.

PictureMate is performing routine maintenance.

PictureMate sounds as though it is printing, but
nothing prints.

1 PictureMate may be preparing to print.
[ Make sure the print head nozzles are not clogged.
To clean the print head, see “Cleaning and

Checking the Print Head Nozzles” on page 65.

[ PictureMate will not work properly if it is tilted or
at an angle. Place it on a flat, stable surface that

extends beyond the printer base in all directions.

1  Make sure paper is not jammed and is loaded
correctly so it can feed into PictureMate. Make
sure the handle is not resting on the paper. See
“Loading Paper” on page 20 for paper loading
instructions.

The memory card does not work correctly.

d Make sure you are using a compatible memory
card. See “Inserting a Memory Card” on page 23.

d Make sure only one card is inserted at a time.
PictureMate does not read from multiple cards at
once.

@ Photos must be in JPEG or Uncompressed TIFF
format and taken with a DCF-compliant camera.

 PictureMate can recognize and print the first 999
photos on your memory card.
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Your printout is blurry or smeared.

Photo Quality Problems

You see banding (light lines) in your prints.

d Useonly paperrecommended by Epsonto ensure
proper saturation, ink absorption, and quality. See
“Ink and Paper” on page 76.
The print head nozzles may need cleaning; see
“Cleaning and Checking the Print Head Nozzles” QO Make sure you load paper with the glossy side
on page 65. face up.
Make sure the glossy side of the paper is face up. O Make sure your paper is not damp or curled, or

The photo cartridge may need replacing. To
replace the cartridge, see “Replacing the
PicturePack” on page 58.

The print head may need aligning; see “Aligning
the Print Head” on page 66.

loaded face down (the glossy side should be face
up). If it is damp or curled, load a new stack of
paper.

Your printout is faint or has gaps in the image.

3

The print head may need aligning; see “Aligning
the Print Head” on page 66.
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a

The print head nozzles may need cleaning; see
“Cleaning and Checking the Print Head Nozzles”
on page 65 for instructions.

The photo cartridge may be old or low on ink. To
replace the photo cartridge, see “Replacing the
PicturePack” on page 58.

Make sure your paper is not damaged, old, dirty,
or loaded face down. If it is, reload a new stack of
paper with the glossy side up.

Colors in your photo are wrong or missing.

a

a

Make sure the Color Effect setting is set to None
for color photos.

The print head nozzles may need cleaning; see
“Cleaning and Checking the Print Head Nozzles”
on page 65.

The photo cartridge may be old or low on ink. To
replace the cartridge, see “Replacing the
PicturePack” on page 58.

Problems With Paper Feeding

Paper does not eject fully or is wrinkled.

If it is wrinkled when it ejects, the paper may be damp
or too thin.

Paper does not feed correctly or jams in the
printer.

0

Make sure the top coveris open, and is notleaning
on the handle. The handle should be back of
PictureMate. Make sure the handle is not resting
on the paper. See “Loading Paper” on page 20.

If paper does not feed, remove it from paper
feeder, reload it in the center, then slide both edge
guides against the paper (but not too tightly).

If multiple pages feed at once, remove the paper
from the paper feeder, separate the sheets, and
carefully reload it.

If paper jams, remove the paper, then press the
OK button to clear the jam.
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1 Load paper glossy side up. Load up to a maximum
of 20 sheets for photo papers. Place the paper in
the center and slide both edge guides against it,
but not so tight that paper cannot move.

Do not load plain paper; this may damage
PictureMate.

d Make sure you are using available paper for
PictureMate (see “Ink and Paper” on page 76).
Store paper flat to help prevent curling.

Miscellaneous Printout Problems

The printer prints blank pages.

The print head may need cleaning. See “Cleaning and
Checking the Print Head Nozzles” on page 65.

The borders or layout are incorrect.
d Check your Layout setting to see if it is correct.

See “Making Paper and Print Layout Settings” on
page 32.

a

If you have a border on one side of your photo but
not the other, make sure the paper is placed in the
center of the paper feeder. Slide the edge guides
against the paper.

If the subject of your photo is very close to the
edge of the image, you can change the amount of
cropping around the edge of the image for
Borderless printing by using Borderless
Expansion from the Setup menu. If you see a
white line around the edge of the print, select MID
or MAX.

The wrong photo is printed.

a

If your camera supports DPOF, you can preselect
photos so PictureMate will print only the ones you
want. See “Printing Camera-Selected DPOF
Photos” on page 31.

If your camera is PictBridge- or USB DP-enabled,
you can connect it to PictureMate and control
printing from your camera. See “Printing From a
PictBridge-Enabled Camera” on page 43.
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Contacting Customer Support

Regional Customer Services

If your Epson product is not operating properly and you
cannot solve the problem using the troubleshooting
information in your product documentation, contact
customer support services for assistance. If customer
support for your area is not listed below, contact the
dealer where you purchased your product.

Customer support will be able to help you much more
quickly if you give them the following information:

[ Product serial number
(The serial number label is usually on the back of
the product.)

[ Product model

@ Product software version
(Click About, Version Info, or similar button in the
product software.)

@ Brand and model of your computer

 Your computer operating system name and
version

O Names and versions of the software applications
you normally use with your product

Note:

For more information on Contacting Customer
Support, see the Online User's Guide included in the
software CD-ROM.

Europe

URL http://www.epson.com

Select the Support section of your local
EPSON web site for the latest drivers,
FAQs, manuals and other
downloadables.

Check your Pan-European Warranty Document for information on how

to contact EPSON Customer support.
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Ink, Paper, and Options

Ink and Paper

The following photo cartridge and Epson special paper
are available for PictureMate. This information is only
for standalone operation.

PictureMate PicturePack T5844
(PictureMate Photo Cartridge and 50 sheets of
PictureMate Photo Paper)

PictureMate PicturePack T5846
(PictureMate Photo Cartridge and 150 sheets of
PictureMate Photo Paper)

Note:
[ The availability of special paper varies by location.

1 Please check your local Epson customer support
Web site where to buy or visit your local dealer.
= See “Contacting Customer Support”on page 75

[ Ifyouwantto use paper other than the types listed
above, refer to the online User's Guide manual.

Epson Premium Glossy Photo Paper 10 x 15 cm S041706

(4x8in.) 5041729
S041822
S041826

Epson Premium Semigloss Photo Paper 10 x 15cm | S041765

(4x61in.)

Epson Ultra Glossy Photo Paper 10 x 15 cm S041926

(4x6in.)

S041943

* For update information, check the Epson support site.

Options

Bluetooth Photo Print Adapter
Bluetooth Photo Print Adapter 2 C12C82438*

Note:

The asterisk is a substitute for the last digit of the
product number, which varies by location.

= See “Printing From a Bluetooth Device” on page 45
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Lithium lon Battery

An optional rechargeable battery means you can use
PictureMate without the AC adapter.

Lithium lon Battery C12C83108:k, model D121A

Note:
The asterisk is a substitute for the last digit of the
product number, which varies by location.

For details on using the optional battery, see the
following section.

Using the Optional Battery

Note:

a

Install the battery after installing the first photo
cartridge and after ink charging is finished.

You cannot save data on the memory card to an
external device when using the battery. Connect
the AC adapter to PictureMate when you save
data.

1  When you copy data on a computer to your

memory card, confirm that there is enough power
in the battery. If the battery runs out, saving is
canceled, and corrupted data may remain on the
memory card.

For safety instructions for the battery, see “When using
the optional battery” on page 11.

Installing the battery

Follow the steps below to install the battery.

1.

2.

Make sure that PictureMate is turned off.
Unplug the AC adapter from the printer.

Press the release latch and remove the battery
cover as shown below.
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Insert the battery into the compartment in the
direction shown below until it is fixed in place.

3. Attach the battery cover as shown below.

Charging the battery

Removing the battery

1.

2.

Make sure that PictureMate is turned off.

Press the release latch and pull out the battery.

Afterinstalling the battery, charge the battery using the
AC adapter.

1.

2.

Make sure that the battery is installed.

Connect the power cord and AC adapter, then
plug in PictureMate.

When PictureMate is off, the power light blinks
during charging. When the battery is fully charged,
the power light turns off.

When PictureMate is on during charging, @7 icon
blinks onthe LCD screen. When the battery is fully
charged, Il icon appears.

78

Ink, Paper, and Options PictureMate PM 240 / PM 280



Note:
The battery may not be charged correctly if the
temperature of the operation is not guaranteed.

Checking the battery status

The battery status is always displayed at the top right
corner of the LCD screen.

Icon

Status

Sufficient battery power

When the icon is green, battery power is low.

When the icon is red, battery power is almost
empty.

Battery power is running out.

Battery is charging.

888 BB

Battery is fully charged.

Battery performance

PictureMate PM 240 | PictureMate PM 280

Charging Time Approx. 120 minutes (Approx. 150 minutes at
maximum)

Continuous Print Approx. 100 minutes * | Approx. 60 minutes **

Time

Number of Prints Approx. 100 sheets Approx. 60 pages **
(4x6in.)*

* When printing from a memory card with a fully charged, fresh battery,
at room temperature. The number of sheets varies depending on the
memory card, data size, and other conditions.

** When printing from CD drive with a fully charged, fresh battery, at room
temperature. The number of sheets varies depending on the data size,
and other conditions.

Auto Power Off

When the battery is used to power PictureMate,
PictureMate will automatically turn off to save battery
power if it is idle for about 15 minutes.

Note:

When a memory card is inserted and PictureMate is
connected to a computer, it will not turn off
automatically.
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Printer Specifications

Mechanical

Model name PictureMate PM 240 PictureMate PM 280

Dimensions Storage Storage
Width : 215 mm Width : 215 mm
(8.5 inches) (8.5 inches)
Depth : 152 mm Depth : 152 mm
(6.0 inches) (6.0 inches)
Height : 145 mm Height : 178 mm
(5.7 inches) (7.0 inches)
Printing Printing
Width: 215 mm Width: 215 mm
(8.5 inches) (8.5 inches)

Depth: 339 mm
(13.3 inches)
Height: 261 mm
(10.3 inches)

Depth: 339 mm
(13.3 inches)
Height: 293 mm
(11.5 inches)

Printable area

Border printing: 3 mm margin for all sides

Borderless printing: 0 mm margin

AC adapterandphoto
cartridge

Paper tray 20 sheets
capacity
Weight 2.4Kg (5.3 Ib) without | 3.0Kg (6.6 Ib) without

AC adapterand photo
cartridge

Electrical
Rating
Printer
AC adapter operated Optional battery
operated
Input DC20V,16A DC 148V, 1.1 A
AC Adapter
Model A381H
Input AC 100-240 V, 50-60 Hz, 0.8-0.4 A, 42 W
Output DC20V,1.68 A
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Printer operated by AC Adapter (PM 240) Power Continuous | Approx. Approx. Approx. Approx.
consumption | printing 19w 19W 34 W 33W
Wh t chargi When chargi using AG
en not charging en charging adapter
optional battery optional battery P ;oovziepower Q%p\ﬁx. ?%p\;gx. QEF\)I(IOX. ZAXl\)I(IOX.
AC AC AC AC
100-120V | 220-240V | 100-120V | 220-240V Power off | Approx. | Approx. | Approx. | Approx.
Input Input Input Input mode 0.4 W 04 W 25 W 25 W
; Input current using AC 0.4A(Max | 0.2A (Max | 0.7 A(Max | 0.4 A (Max
Power Continuous | Approx. Approx. Approx. Approx. ‘
consumption | printing 19W 19W 34 W 33W ad_apter (Continuous 0.5A) 0.3A) 0.8 A) 0.5A)
using AC printing)
adapter Low power | Approx. Approx. Approx. Approx.
mode 4.0W 4.0W 24 W 24 W
Power off | Approx. Approx. Approx. Approx. H
mode 0.4 W 4.0W 25 W 25 W En V’ronmental
Input current using AC 0.4A(Max | 0.2A(Max | 0.7 A(Max | 0.4 A (Max -
adapter (Continuous 0.5 A) 0.3 A) 0.8 A) 0.5 A) Temperature Operation: .
printing) 10 to 35 °C (50 to 95 °F)
Storage:
-20 to 60 °C (-4 to 140 °F)
Printer Operated by AC Adapter (PM 280) 1 month at 40 °C (104 °F)
Humidity Operation:*
. . 20 to 80% RH
When not charging When charging
optional battery optional battery
* Without condensation
AC AC AC AC
100-120V | 220-240V | 100-120V | 220-240 V
Input Input Input Input
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Memory card slots

Card Slots

CF Type Il card
slot

Compatible with “CF+ and
CompactFlash Specification
1.4

Memory Stick/
Memory Stick
PRO card slot

Compatible with “Memory
Stick Standard version 1.3”

Compatible with “Memory
Stick Standard Memory Stick
PRO Format Specifications
version 1.0”

SD/
MMC card slot

Compatible with “SD Memory
Card Specifications / PARTT.
Physical Layer Specification
Version 2.00"

Compatible with
“MultiMediaCard Standard”

xD-Picture card
slot

Compatible with “xD-Picture
Card™ Card Specification
Version 1.20 Type M cards /
Type H cards”

Compatible
memory cards

CompactFlash

Memory Stick*

Memory Stick PRO
Memory Stick Duo**
Memory Stick PRO Duo**
MagicGate Memory Stick*
MagicGate Memory Stick Duo**
Microdrive

SDHC Memory Card

SD Memory Card
miniSDHC card**

miniSD card**
microSDHC card**
microSD card**
MultiMediaCard
xD-Picture Card
xD-Picture Card Type M
xD-Picture Card Type H

Voltage
Requirements

3.3V
3.3 V/5V Combined use

Maximum current is 500 mA

* Maximum capacity is 128 MB.

** Adapter required.
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Note:

For the latest information on memory cards available
for your printer, contact your dealer or regional Epson

sales office.

CD drive

This specifications are for PictureMate PM 280 only.

Compliant CD (Read and Write)

* CD-R

* CD-RW Multi

e CD-RW High

* CD-RW Ultra

All of the above media types support both 650 MB (74 min) and 700
MB (80 min) capacities.

Drive Transfer rate

AC power

Use with battery

Read and verify
rate

24x CAV CD-ROM

12x CAV CD-ROM

Writing rate

8x CD-R,

4x CD-RW Multi,
8x CD-RW High,
8x CD-RW Ultra

8x CD-R,

4x CD-RW Multi,
8x CD-RW High,
8x CD-RW Ultra

Photo Cartridge

PictureMate Photo Cartridge

Color

Black, Cyan, Magenta and Yellow

Cartridge life

Use within 6 months of opening the package.

Temperature

Storage:
-30 t0 40 °C (-22 to 104 °F)

1 month at 40 °C (104 °F)

Freezing:*
-15°C (5 °F)

* Ink thaws and is usable after approximately 3 hours at 25 °C (77 °F).

External Storage Devices

Connectivity

Universal Serial Bus*

Bit rate: 480 Mbps (High speed device)
Connector type: USB Series A

Data Encoding: NRZI

Recommended cable length: Less than 1.8 meters

* Not all USB devices are supported. Contact your regional customer
support for details.
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Standards and Approvals

Printer
U.S. model:
Safety UL60950-1
CSA No.60950-1
EMC FCC Part15 Subpart B Class B

CAN/CSA-CEVIEC CISPR22 Class B

European model:

EMC EN55022 Class B
EN55024
EMC Directive 89/336/EEC

Australian model: (For PictureMate PM 240/250 only)
EMC AS/NZS CISPR22 Class B

AC Adapter
U.S. model:

UL60950-1

CSA No.60950-1
EMC FCC Part15 Subpart B Class B

CAN/CSA-CEVIEC CISPR22 Class B

Safety

European model:

Low Voltage Directive 72/23/EEC

EN60950-1
EMC EMC Directive 89/336/EEC

EN55022 Class B
EN55024
EN61000-3-2
EN61000-3-3

Safety

Australian model:

Safety AS/NZS 60950.1
EMC AS/NZS CISPR22 Class B
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Index

A

All photos, 27
Auto correct photo, 33

B

Battery
buying, 77
using, 77
Black and white printing, 18
Blank pages, 74
Bluetooth, 45, 76
Blurry prints, 72

(o

Camera
printing from, 43

selected photos (DPOF), 31

Care of PictureMate, 65
Carrying PictureMate, 63
CD

printing from, 41

saving files to, 53
CD Index, 18, 55, 57
Cell phone

printing from, 45
Charging ink, 71

Cleaning

printer, 68

print head, 65
clip art, 35
Clogged nozzles, 65
Color

problems, 73
Consumables, 76
Crop

photo, 36

D

Date Stamp, 34
Device
external, 41 to 44
DPOF (Digital Print Order Format), 31

E

Edge guide, 21

Error Messages, 69

External device
external, 41 to 44

F

Faint images, 72
File formats, 17
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Fix photo, 33

Flash memory drive
printing from, 41
saving files to, 53

Front cover, 21

G
Gaps inimage, 72

1

Image
formats, 17
quality, 72 to 73
Incorrect colors, 73
Index sheet, 31

Ink, see Photo cartridge

J

Jams
paper, 73
JPEG, 17
L
LCD screen
messages, 69

M

Maintenance, 65
Manuals, 17

Margins
incorrect, 74
Memory card
compatibility, 82
inserting, 23
problems, 69, 71
removing, 25
Memory Stick, 23
Menu List, 18
Microdrive, 23
Missing colors, 73
MMC (MultiMediaCard), 23

N

Noise

PictureMate, 71
Nozzle check, 65
Nozzle cleaning, 65

(0]

On button, 23
Options, 76

P

Packing PictureMate, 63
Paper
buying types, 76
feeding problems, 73 to 74
jam, 73

86 Index PictureMate PM 240 / PM 280



PDA

printing from, 45
Photo

formats, 17

quality, 72 to 73
PictBridge, 16, 43
PictureMate PicturePack, 76
PicturePack

buying, 76

replacing, 58 to 62

safety instructions, 13
P.I.LF. Frame, 37
PIM (PRINT Image Matching), 16
Power cable, 63
Problems

memory card, 71

missing colors, 73

paper feeding, 73 to 74

paper jam, 73

print quality, 72 to 73

Q
Quality, 72 to 73

R

Removing
memory card, 25
photo cartridge, 58
Resolution, 17

S

Save photos, 53

SD (Secure Digital) card, 23
Sepia, 18

Setup problems, 71
Smears, 72

T

Technical support, 75
Thumb drive

printing from, 41

saving files to, 53
TIFF, 17
Transporting PictureMate, 63
Troubleshooting, 69 to 74

U

USB cable, 43, 63

USB DP (USB Direct Print), 16, 43
User’'s Guide, 18

X

xD Picture Card, 23

V4

Zip disk
printing from, 41
saving files to, 53
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